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HLG Photos
HLG Photos Defined

“HLG photos” are photos that support a wider range of brightnesses (i.e., dynamic range) than do SDR
(Standard Dynamic Range) JPEG pictures. The Z 8 supports HLG with two formats: RAW (extension
“.NEF”) and HEIF (extension “.HIF”).

Tip: HLG
Developed for television broadcasting and other high-definition applications, Hybrid Log-Gamma
(HLG) technology is a High Dynamic Range (HDR) standard that allows for photographs with a wider
range of tones, minimizing loss of detail in highlights and shadows.

Compared with Standard Dynamic Range (SDR), it increases the amount of detail that can be
expressed in the upper half of the tone range for greater rendering potential.
It matches SDR in the level of detail that can be expressed in the lower portion of the tone range to
ensure compatibility with non-HDR displays.
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SDR HLG

The Benefits of HLG
HLG photos have a wider dynamic range than those recorded using SDR. They are consequently
capable of reproducing colors in rich detail, similar to how they actually appear to the human eye.
HLG minimizes loss of detail in highlights and shadows to render a richer range of tones in all areas
of photos featuring scenes that include both bright and dark areas, such as, for example, sunsets and
sunrises. It also serves to reduce loss of detail in highlights in scenes featuring bright light sources such
as light shows or the sun.

Note: These images are concept art intended to illustrate the differences between SDR and HLG. The
tones differ from those that would be seen in the actual images.
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Select photo mode by rotating the photo/video selector to
C.

Highlight [Tone mode] and press J.
Tone mode options will be displayed.

Taking and Editing HLG Photos
Configuring the Camera for HLG

Choosing the HLG Tone Mode
To take HLG photos, select the HLG tone mode. The selection can be made via either the i or the
photo shooting menu.

The i Menu

Press the i button or tap the i icon in the monitor to view the i menu for photo mode.
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Highlight [HLG] and press J.
This selects the highlighted option and returns you to the i
menu.

Press the G button to view the menus.

After highlighting the C tab to display the photo shooting
menu, highlight [Tone mode], and press the multi selector
right (2).

Highlight [HLG] and press J.
This selects the highlighted option and returns you to the
menus.

The Photo Shooting Menu
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Select photo mode by rotating the photo/video selector to
C.

Highlight [Image quality] and press J.
Image quality options will be displayed.

Highlight the desired option and press J.
This selects the highlighted option and returns you to the i
menu.
For information on the options available, see “Image Quality
Options” ( 0 9).

Adjusting Image Quality
The Z 8 supports HLG with two formats: RAW (NEF) and HEIF. Depending on the option selected for
image quality, photos can be recorded only in RAW (NEF) format, only in HEIF format, or in both
formats. The selection can be made via either the i or the photo shooting menu.

The i Menu

Press the i button or tap the i icon in the monitor to view the i menu for photo mode.
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Press the G button to view the menus.

After highlighting the C tab to display the photo shooting
menu, highlight [Image quality], and press the multi
selector right (2).

Highlight the desired option and press J.
This selects the highlighted option and returns you to the
menus.
For information on the options available, see “Image Quality
Options” ( 0 9).

The Photo Shooting Menu
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Image Quality Options
The image quality options available when HLG is selected for tone mode are listed below.

Option Description

[RAW + JPEG/HEIF finem] Record two copies of each photo: an NEF (RAW) picture and an
HEIF copy.

Choose options with a star (“m”) to maximize the quality of the
HEIF copies. Choose options without a star (“m”) to ensure that
the HEIF copies all have more or less the same file size.
The camera displays only the HEIF copy of dual-format pictures
taken with one memory card inserted.
If the photo was recorded with only one memory card inserted
or with [Overflow] or [Backup] selected for [Secondary slot
function] in the photo shooting menu and two memory cards
inserted, deleting the HEIF copy on the camera will also delete
the NEF (RAW) picture.

[RAW + JPEG/HEIF fine]

[RAW + JPEG/HEIF normalm]

[RAW + JPEG/HEIF normal]

[RAW + JPEG/HEIF basicm]

[RAW + JPEG/HEIF basic]

[RAW] Record photos in NEF (RAW) format.

[JPEG/HEIF finem]

Record photos in HEIF format. ”Fine” produces higher quality
pictures than ”normal” and ”normal” higher quality pictures than
“basic”.

Choose options with a star (“m”) to maximize image quality.
Choose options without a star (“m”) to ensure that the files are
more or less the same size.

[JPEG/HEIF fine]

[JPEG/HEIF normalm]

[JPEG/HEIF normal]

[JPEG/HEIF basicm]

[JPEG/HEIF basic]
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D Taking Photos in HLG
Pictures taken with HLG selected for tone mode exhibit more “noise“ (in the form of randomly-
spaced bright pixels, fog, and lines) than do pictures taken using SDR.
The performance of subject-detection may drop during autofocus.
The lowest value available for the [ISO sensitivity settings] > [Maximum sensitivity] item in the
photo shooting menu is ISO 800.
ISO sensitivities of Hi 0.3 through Hi 2.0 are not available.
The video file type for time-lapse videos is fixed at [H.265 10-bit (MOV)].
[Color space] in the photo shooting menu is fixed at "BT.2100".
[Active D-Lighting], [Multiple exposure], and [HDR overlay] are not available in the photo
shooting menu.
[C30], [C60], and [C120] cannot be selected for release mode and Custom Setting d3 [Pre-Release
Capture options] is not available.
Buffer capacity drops when [Large] is selected for [Image size settings] > [Image size].

D Cautions: HLG Photos
Photos shot with HLG selected for tone mode are subject to the following restrictions:

Image overlay is not available with HLG photos. HLG photos will not be displayed in the picture
selection dialogs for the various image overlay options available via [Retouch] in the playback i
menu.
The SnapBridge app can be used to download but not to view HLG photos.

Photos taken with HLG selected for tone mode may not display correctly on monitors that are not
HDR-compatible.

D Camera Shooting and Playback Displays
When HLG is selected for tone mode, the shooting and playback displays in the camera monitor and
viewfinder may include “noise” in the form of randomly-spaced bright pixels, fog, or lines or may fail
to accurately reproduce highlights and highly-saturated colors. In addition, abrupt tone discontinuities
may be visible in the camera monitor or viewfinder when photos are displayed full-frame, although the
photos themselves are unaffected. For accurate tone reproduction, use monitors, computers, operating
systems, applications, and other equipment compatible with HDR.
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Tip: Editing HLG Photos
HLG photos can be edited on the Z 8 using the [Retouch] item in the playback i menu. The
following options can be used:

RAW processing (current picture; NEF/RAW pictures only)
RAW processing (multiple pictures; NEF/RAW pictures only)
Trim
Resize (current picture)
Resize (multiple pictures)
D-Lighting
Straighten
Distortion control
Perspective control
Monochrome

HLG photos can also be edited using Nikon’s NX Studio software. The options available vary with
the file format. For more information, see “Editing (Enhancing) HLG Photos in NX Studio” ( 0 18).

Tip: RAW Processing
NEF (RAW) photos shot with HLG selected for tone mode can be converted to JPEG or HEIF using
the [Retouch] item in the playback i menu (RAW processing). During this process, Picture Controls
and settings such as exposure compensation and white balance can be freely adjusted. Note,
however, that the JPEG copies may exhibit more “noise” in the form of randomly-spaced bright
pixels, fog, or lines than do JPEG copies created from NEF (RAW) pictures taken with SDR selected
for tone mode.
NEF (RAW) photos can also be saved in other formats using Nikon’s NX Studio software. For more
information, see “Saving Pictures in Other Formats Using NX Studio” ( 0 25).
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Viewing HLG Photos on a Computer
What You’ll Need
The following are the system requirements for the correct display of tones when viewing HLG photos.

Windows

OS

Windows 11
Windows 10

Version 1709 or later
Latest graphics driver (WDDM)

GPU HDR10 compatible with support for PlayReady digital rights
management (DRM)

Monitor DisplayHDR 1000 (recommended)

Cable HDMI 2.0a or later
DisplayPort 1.4 or later

Software NX Studio (be sure to install the latest version)

D Monitors That Do Not Satisfy the DisplayHDR 1000 Standard
Highlights in HLG photos may seem “washed out” when viewed on DisplayHDR/True Black 400, 500, or
600 monitors.
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●NX Studio
To display HLG photos, you will need to install Nikon’s NX Studio software. Doing so allows you to
view and edit photos and videos shot with Nikon digital cameras. Download the latest version of
the NX Studio installer from the website below and follow the on-screen instructions to complete
installation.
https://downloadcenter.nikonimglib.com/

D Installing the Codec
Viewing HLG photos in NX Studio requires the corresponding “Imaging Codec 01” codec. The codec
can be installed by following the instructions displayed the first time an HEIF-format (extension “.hif”)
HLG photo is opened, selected, or saved in another format in NX Studio.

You must provide the camera serial number before downloading Imaging Codec 01.

●Configuring Your Computer
The computer must be configured as described below. More information on the settings below is
available from the Microsoft website.

Enable HDR in Windows display settings.
Enable HDR video streaming.

D Displaying HLG Photos in Single-Frame View
Selecting high values for HDR/SDR brightness balance will brighten the entire display, making the
difference between HLG and non-HLG (SDR) photo displays difficult to discern. Selecting the lowest
setting for HDR/SDR brightness balance when viewing HLG photos brings the mid-tones for HDR
closer to those for SDR, making the HDR effect easier to see.

Tip: Monitor Settings
Depending on the model, you may need to adjust settings on your monitor. See the monitor
documentation for more information.
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macOS

Monitor Liquid Retina XDR (including built-in MacBook Pro displays) or Pro
Display XDR

Software NX Studio (be sure to install the latest version)

D Other Monitors
Highlights in HLG photos may seem “washed out” if not viewed on a Liquid Retina XDR or Pro
Display XDR monitor. This can sometimes be addressed by lowering display (monitor) brightness in the
computer’s system settings.

●NX Studio
To display HLG photos, you will need to install Nikon’s NX Studio software. Doing so allows you to
view and edit photos and videos shot with Nikon digital cameras. Download the latest version of
the NX Studio installer from the website below and follow the on-screen instructions to complete
installation.
https://downloadcenter.nikonimglib.com/

●Configuring Your Computer
You will need to select the “HDR Video (P3‑ST 2084)” reference mode preset in display settings. More
information is available from the Apple website.
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Viewing HLG Photos on a Computer
HLG photos are identified by “HLG” icons in the NX Studio thumbnail list.
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The [File Info 2] pane in the info tab of the adjustments/info palette lists the tone mode as “HLG”,
while the [Image Settings] pane lists the color space as “BT.2100”.
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Ensuring That Tones Are Displayed Correctly
“HDR” icons appear at the bottom right corners of HLG photos displayed in single-frame view in
NX Studio on HDR-compatible monitors. This indicates that tones are displayed correctly.

D Monitors That Do Not Satisfy the DisplayHDR 1000 Standard
Highlights in HLG photos may seem “washed out” when viewed on a Windows computer with a display
that does not satisfy the DisplayHDR 1000 standard.
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Editing (Enhancing) HLG Photos in
NX Studio

HLG photos can be edited (enhanced) using the tools in the [Adjustments] tab of the NX Studio
adjustments/info palette. The following tools are available.
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[Basic Edit Palettes] (RAW pictures only)
Picture Controls
White balance
Exposure compensation

[Levels & Curves]
Contrast
Tone curves (brightness)
Color balance

[Portrait Enhancements] (RAW pictures only)
Skin softening
Portrait impression balance
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[Adjust Details] (RAW pictures only)
Noise reduction

[Touch-up]
Retouch brush

[Adjust Composition]
Crop
Straighten
Perspective control

[Camera and Lens Corrections]
Lateral color aberration
Auto distortion control
Vignette control
Diffraction compensation (RAW pictures only)
Fisheye
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Enhancing HLG Photos
Enable [Adjust using HDR] in the [Adjustments] tab. Enabling this option allows edits to photos in
the HDR tone range.

Remove the check to use the SDR tone range.
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Picture Controls (HLG)
Enabling [Adjust using HDR] enables the [Set Picture Control (HLG)] Picture Control tool. Note that
HLG Picture Controls are available only with RAW pictures taken with HLG selected for tone-mode.

The Picture Control tool changes to [Set Picture Control] when [Adjust using HDR] is disabled.
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 Color reproduction process: Fixed at [Camera compatible]; cannot be changed.

 Picture Control: Choose a Picture Control for the pictures in the current selection.

 Picture Control parameters: Adjust Picture Control parameters. Note that even in the case of
pictures taken under similar conditions, the results may vary with exposure and the position and
size of the subject in the frame.

 [Reset]: Reset all parameters to their default values.

D Caution: Enabling or Disabling “Adjust Using HDR”
Enabling or disabling [Adjust using HDR] resets all Picture Control settings.

Disabling [Adjust using HDR] after choosing [[HLG SD] Standard], [[HLG MC] Monochrome],
or [[HLG FL] Flat] for [Set Picture Control (HLG)] changes the selection to the corresponding
[Picture Control] option, respectively [Standard], [Monochrome], or [Flat].

Picture Control (HLG) Parameters
Adjust Picture Control parameters. The parameters available vary with the Picture Control selected.

[Quick sharp]
Quickly adjust levels for balanced [Sharpening], [Mid-range sharpening], and [Clarity]. The various
sharpening parameters can also be adjusted individually.

[Sharpening]: Control the sharpness of details and outlines.
[Mid-range sharpening]: Adjust the sharpness of patterns and lines at levels of detail between
those to which [Sharpening] and [Clarity] apply.
[Clarity]: Adjust overall sharpness and the sharpness of thicker outlines without affecting
brightness or dynamic range.

[Contrast]
Adjust contrast. Choose lower values for less contrast, higher values for more contrast.

[Highlights]
Adjust brightness in bright areas of the photo (highlights). Choose higher values for greater
brightness.

[Shadows]
Adjust brightness in dark areas of the photo (shadows). Choose higher values for greater brightness.
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[Saturation]
Control the vividness of colors. Choose lower values for more muted colors and higher values for
more vivid colors.

[Hue]
Adjust hue.

[Filter Effect]
Simulate the effects of color filters on monochrome photos. This parameter is available only with the
[[HLG MC] Monochrome] Picture Control.

[Toning]
Choose a base tint for results that mimic the effects of printing photos on tinted paper. This
parameter is available only with the [[HLG MC] Monochrome] Picture Control.

[Adjust Saturation]
Choose the saturation of the tint selected for [Toning]. This parameter is available only with the
[[HLG MC] Monochrome] Picture Control. Note, however, that saturation cannot be adjusted when
[B&W] is selected for [Toning].
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Saving Pictures in Other Formats Using
NX Studio

NX Studio can be used to create JPEG, HEIF, or TIFF format copies of photos taken with HLG selected
for tone mode. RAW (NEF) and HEIF photos can be viewed in third-party software that does not
support these formats by converting them to JPEG or TIFF. If desired, entire folders can be selected for
conversion to other formats.

Saving Pictures in Other Formats: An Overview
Click [Export] in the toolbar.
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A dialog will be displayed where you can adjust image quality, size, and other settings.

For information on the options available, see “Export Options” ( 0 28).
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Click [Export].

The copies will be saved in the selected folder.

D RAW Pictures
[Export] can be used to save RAW pictures in other formats. To save RAW pictures without converting
them to other formats, use [Save] or [Save As] in the [File] menu. More options for use when saving
pictures can be found in the [Save] section of the [Options] dialog.
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Export Options
The following settings can be adjusted:

[Original Image]
Export the pictures in the current selection or in selected folders.

[Selected images]: Export the pictures in the current selection.
[Selected folder]: Export all pictures in a selected folder. To choose the folder, click [Browse].

[Include subfolders]: Include pictures in all sub-folders under the selected folder.
[Delete originals after operation]: Delete the original pictures from the folder once export is
complete.

[Export as]
Choose a format for the exported files from [JPEG], [TIFF (8 Bit)], [TIFF (16 Bit)], [HEIF (HLG)], and
[HEIF (PQ)].

Files with thumbnails marked “PQ” cannot be saved in other formats.
[HEIF (HLG)] and [HEIF (PQ)] will be available only if the thumbnail for the source file is marked
“HLG”.
The estimated total size is not displayed when an HEIF option is selected.
[Quality]: Choose the compression ratio for pictures exported in JPEG or HEIF format. The JPEG
compression ratio can be selected by dragging the slider or entering the desired value. In the
case of HEIF, Windows offers a choice of [Highest Compression Ratio], [Good Compression
Ratio], [Good Balance], [Good Quality], and [Excellent Quality]. macOS does not offer a choice
of HEIF compression settings.
[Use LZW Compression]: This option is available when pictures are saved in TIFF format. Select it
to compress the files using a lossless LZW compression algorithm.

D LZW Compression
Enabling LZW compression when converting pictures to 16-bit TIFF may increase file size.

D “HEIF (HLG)” and “HEIF (PQ)”
Pictures exported with [HEIF (HLG)] or [HEIF (PQ)] selected for [Export as] will be saved
respectively in HLG or PQ (Perceptual Quantization) HEIF format.

While HLG and PQ formats both conform to the HDR standard, they differ in the following
respects.

HLG represents luminosity as a relative value, meaning that luminosity varies with the device
on which the picture is displayed.
PQ represents luminosity as an absolute value, meaning that luminosity does not vary with the
device on which the picture is displayed.

Pictures converted to PQ HEIF using the [HEIF (PQ)] option have thumbnails marked “PQ” and
can no longer be edited in NX Studio.
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[Resolution]
Export pictures at new resolutions.

[Change image size]
Resize pictures during export. Entering a value for [Long edge] automatically updates [Short
edge] to maintain aspect ratios. The units can be selected from [pixels], [inch] (inches), and [cm]
(centimeters).

[Remove camera setting information]
Strip shooting data from pictures during export.

[Remove XMP/IPTC information]
Strip XMP/IPTC information from pictures during export.

[Add/Remove ICC color profile] (not displayed when [HEIF (HLG)] or [HEIF (PQ)] is selected for
[Export as])

To add or remove color profiles, select this option and choose [Add] or [Remove]. The profiles
added when [Add] is selected vary with the option selected for [Color Management] in the
[Options] dialog. The color profiles available for [Color management] are described below.

If only [Use this instead of an embedded profile when opening images] is selected, the
[Default RGB color space] profile (or in macOS, [RGB Default Profile]) will be embedded in
pictures during export.
If only [Convert images to sRGB color space when they are converted into JPEG/TIFF
format] is selected, the sRGB color profile will be embedded in pictures during export.
If both are selected, the sRGB color profile will be embedded in pictures during export.
If neither is selected, the original color profile will be embedded in pictures during export.

[Save in]
Choose the destination folder for the exported pictures.

[Same folder as originals]: Save the exported pictures to the same folders as the original files.
[Specified folder]: Save the exported pictures to a selected folder. To choose the destination,
click [Browse].

[Create a new subfolder for each export]: Automatically create a new sub-folder within the
chosen folder each time pictures are exported. To choose how the folders are named, click
[Naming Options].

[Change file names]
Rename files during export. To choose how the files are named, click [Naming Options].
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Converting Pictures to Color Spaces Other than
sRGB
RAW pictures taken in the sRGB color space can be converted to other color spaces during export.
Note, however, that the color space for RAW pictures recorded with HLG selected for tone mode is
fixed at BT.2100, regardless of the color space selected at export or in the options (preferences) dialog.

Choose the desired default RGB color space for [Options] > [Color Management] > [Color
Matching Profile] and select [Use this instead of an embedded profile when opening
images].
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Remove the check from [Convert images to sRGB color space when they are converted
into JPEG/TIFF format] under [Output] in the [Color Management] panel.
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Select the desired option for [Options] > [NEF (RAW) Processing] > [Color Space for Color
Reproduction].

Tip: “Color Space for Color Reproduction”
The current color space for color reproduction can be viewed using the i button on the camera.
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Select [Export] > [Add/Remove ICC color profile] and choose [Add].

Click [Export].

The pictures will be exported in the selected color space.
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Tip: Restoring the sRGB Color Space
To restore pictures to the sRGB color space:

select [sRGB] for [Options] > [NEF (RAW) Processing] > [Color Space for Color Reproduction],
place a check next to [Convert images to sRGB color space when they are converted into JPEG/
TIFF format] under [Output] in the [Color Management] panel, and
select [Nikon Adobe sRGB 4.0.0.3002] for [Options] > [Color Management] > [Color Matching
Profile] and remove the check from [Use this instead of an embedded profile when opening
images].
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Troubleshooting
Problems and Solutions

● HLG (HEIF) photos do not display correctly:
Pictures taken with HLG selected for tone mode may not display correctly when viewed on other
devices (for example, when output to other devices directly or when opened on a computer after
upload). View the pictures on an HDR-compatible computer or other device. For more information
on viewing HLG pictures on a computer, visit the following website:
https://onlinemanual.nikonimglib.com/notice/hlg_setting_guide/en/

● Output to HDMI devices does not function as expected:
Photos taken with HLG selected for tone mode may not display correctly on devices that are not
HDR-compatible.

● The effects of [Set Picture Control], [Set Picture Control (HLG)], [Active D-Lighting], or
[Vignette control] are not visible when pictures are viewed on a computer:
In the case of NEF (RAW) pictures, the effects can (as of May 2023) only be viewed using Nikon
software. View NEF (RAW) pictures using NX Studio.
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